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Documentation Conventions

OPNET documentation uses specific formatting and typographic conventions to present 
the following types of information:

• Objects, examples, and system I/O

• Object hierarchies, notes, and warnings

• Computer commands

• Lists and procedures

Objects, Examples, and System I/O

• Directory paths and file names are in plain Courier typeface:

opnet\release\models\std\ip

• Function names in body text are in italics:

op_dist_outcome()

• The names of functions of interest in example code are in bolded Courier 
typeface:

/* determine the object ID of packet’s creation module */
src_mod_objid = op_pk_creation_mod_get (pkptr);

• Variables are enclosed in angle brackets (< >):

<opnet_user_home>/op_admin/err_log

Object Hierarchies, Notes, and Warnings

Menu hierarchies are indicated by right angle brackets (>); for example:

Open File > Print Setup > Properties...

Attribute hierarchies are represented by angled arrows (➘ ) that indicate that you must 
drill down to a lower level of the hierarchy:
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Attribute level 1 ➘ Attribute level 2 ➘ Attribute level 3

Note—Notes are indicated by text with the word Note at the beginning of the 
paragraph. Notes advise you of important supplementary information.

WARNING—Warnings are indicated by text with the word WARNING at the 
beginning of the paragraph. Warnings advise you of vital information about an 
operation or system behavior.

Computer Commands

These conventions apply to windowing systems and navigation methods that use the 
standard graphical-user-interface (GUI) terminology such as click, drag, and dialog box.

• Key combinations appear in the form “press <button>+x”; this means press 
the <button> and x keys at the same time to do the operation.

• The mouse operations left-click (or click) and right-click indicate that you 
should press the left mouse button or right mouse button, respectively.

Lists and Procedures

Information is often itemized in bulleted (unordered) or numbered (ordered) lists:

• In bulleted lists, the sequence of items is not important.

• In numbered lists, the sequence of items is important.

Procedures are contained within procedure headings and footings that indicate the start 
and end of the procedure. Each step of a procedure is numbered to indicate the 
sequence in which you should do the steps. A step may be followed by a description of 
the results of that step; such descriptions are preceded by an arrow.

Procedure FM-1 Sample Procedure Format 

1 Procedure step.

➥ Result of the procedure step.

2 Procedure step.

End of Procedure FM-1

For more information about using and maintaining OPNET documentation, see the 
OPNET IT Guru Documentation Guide.
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Document Revision History

Release Date
Product 
Version Chapter Description of Change

April 2005 11.0 PL3 Licensing • Combined License Manager and License Server chapters.

• Updated content with information from various Technical 
Support FAQs.

February 2005 11.0 PL3 License Server • Added information from FAQ 725 for diagnose mode.

October 2004 11.0 PL1 License Manager • Added various information on license file conversion.

License Server • Added requirement to stop and restart server when Restricting 
License Server Administration and Restricting License Users.

• Updated and clarified procedures for Starting the License 
Server.

• Added information about License File Format Conversion.

August 2004 11.0 License Manager • Changed data type of license_http_proxy_password and 
license_password preferences.

License Server • Added information on loan authorization files in Restricting 
Loanable Licenses.

March 2004 10.5 PL1 Installation Support • Corrected the command line in Procedure 2-8 Updating from a 
Previous Release (UNIX) on page AG-2-10

• Deleted obsolete procedures for installing OPNET in a different 
directory (WIN and UNIX)

January 2004 10.5 PL0 License Manager • Added preferences license_http_proxy_password, 
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a Loanable License, Change Authorized Loan Duration 
(button), and Change Loan Properties (button).

January 2003 10.0 ALL • First Issue
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Administrator Guide 1—Basic Concepts
1 Basic Concepts

This manual contains installation support information and a description of the 
OPNET license system. The information and procedures in this manual are for 
system administrators or IT Guru users who install and maintain computing 
environments in UNIX or Windows operating systems, and need to do the 
following tasks:

• Install new user accounts

• Update the IT Guru software

• Relocate IT Guru software

• Use the license system

What You Need to Know

To do the administrator tasks described in this manual, you need to know the 
following concepts and techniques:

• For UNIX installations

— techniques of becoming super-user: su, login, rlogin

— disk partition, directory, file, and path name concepts

— Network Filesystem (NFS) concepts

— C shell usage and conventions

— host workstation directory organization

— basic directory and file commands: cd, mkdir, chmod, chown

• For Windows installations

— techniques of becoming administrator (Windows)

— disk partition, directory, file, and path name concepts

— command interpreter usage and conventions

— host workstation directory organization

— basic directory and file commands: cd, mkdir

If you are not familiar with these concepts, you may want to obtain the 
assistance of an in-house system administrator familiar with UNIX or Windows. 
Alternatively, you may prefer to develop the necessary skills yourself, either by 
acquiring a beginning text or attending a beginning class.
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Terminology

architecture
directory

An architecture-specific system directory within a particular IT Guru release. 
IT Guru executables and libraries are typically stored in this directory. 
Architecture directories are subdirectories of the sys directory of a particular 
release. In this manual, the symbol <arch> represents an architecture 
directory. The following table lists the names used for this directory under the 
various architectures supported by IT Guru.

binary directory A directory containing the IT Guru binaries. The binaries for a specific release 
and computer architecture are located in <reldir>/sys/<arch>/bin. 
Under UNIX a special binary directory contains scripts that allow IT Guru to 
locate the binaries for the platform being used.

In this manual, the symbol <bindir> represents the path to a binary directory. 
For example, if IT Guru 11.5.A is installed in the directory /usr/opnet, then 
<bindir> represents the Solaris path name

/usr/opnet/11.5.A/sys/sun_sparc_solaris/bin

or the Windows path name

\opnet\11.5.A\sys\pc_intel_win32\bin

CD-ROM directory;
CD-ROM drive

The mount point for the CD-ROM drive of the install workstation. The symbol 
<cd_dir> represents the CD-ROM directory in this manual. (Under Windows, 
the CD-ROM drive will be mounted at a particular drive letter, rather than a 
directory. The symbol <cd_drive> represents the drive letter of the CD-ROM 
drive.)

client workstation A workstation used to execute IT Guru programs. Each client workstation must 
have access to the IT Guru directory, either on its local disk, on a server disk, or 
via the Network Filesystem (NFS).

Table 1-1   Architecture Directory Names

Vendor CPU
Operating 
System <arch> Directory Name

Sun Microsystems SPARC Solaris sun_sparc_solaris

various various all UNIX systems unix

various Pentium Windows pc_intel_win32
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install workstation A workstation with a compatible CD-ROM drive. This workstation must be able 
to mount the server workstation disk partition containing the OPNET directory 
via the Network Filesystem. At many sites, the server workstation has a 
CD-ROM drive and is therefore also the install workstation. At completely 
stand-alone sites, a single workstation fills all three roles: client, server, and 
install workstation.

library directory A directory containing the IT Guru libraries. The libraries for a specific release 
and computer architecture are located in <reldir>/sys/<arch>/lib.

In this manual, the symbol <libdir> represents a library directory. For 
example, if IT Guru is installed in the directory /usr/opnet under Solaris, then 
<libdir> represents the directory path name 
/usr/opnet/11.5.A/sys/sun_sparc_solaris/lib.

licensing system The licensing system allows you to run IT Guru or another licensed application 
on any workstation on the local network. See The Licensing System on 
page AG-3-1 for a description of the important components of this system.

OPNET directory The directory in which the IT Guru system software is or will be loaded. You can 
choose where to place IT Guru in the directory tree; almost any location will 
work. However, because the IT Guru system software occupies a significant 
amount of disk space, the disk partition holding the OPNET directory must have 
enough free space before installation begins (refer to the OPNET web site to 
determine the amount of partition free space required).

A typical location for the OPNET directory is:

Windows: C:\Program Files\Cisco

The symbol <opnet_dir> represents the OPNET directory. Typically, there 
is only one path name to the OPNET directory. Different subdirectories within 
the OPNET directory may contain different releases of the IT Guru software.

release CD-ROM The distribution media supplied as part of the IT Guru release materials.

release directory A directory containing the software for a particular IT Guru release. Release 
directories are subdirectories of the OPNET directory. In this manual, the 
symbol <reldir> represents the release directory.

server workstation The workstation that stores the OPNET directory on its disk. A server 
workstation may also be a client workstation. More commonly, however, a 
server workstation is a file server that is shared by a workgroup.
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2 Installation Support

This chapter provides information that supports the basic IT Guru installation 
instructions provided on the installation sheets. This information includes the 
following:

• Installation troubleshooting suggestions

• Procedures for updating or moving existing software

• Procedures for running previous releases

• Procedures for removing and relocating software

In most cases, you won’t need the information contained here. It is provided for 
any special cases that might arise.

For information about supported platforms, memory usage, and other 
requirements, visit the Technical Support area of the OPNET website at 
(www.opnet.com/support).

UNIX Installation Support

Most sites should follow the installation procedure described on the UNIX 
Installation sheet. This procedure uses the installation program to configure 
your workstation automatically and install IT Guru. However, if your workstation 
has an unusual or incorrect configuration, the installation program may fail. If so, 
you can use the information here to solve the problem.
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UNIX Installation Troubleshooting

This section provides solutions for problems that may occur during UNIX 
installations. Each problem has a discussion section that explains what is 
happening and a solution section that explains how to solve the problem. If your 
problem is not described here, contact Technical Support for help.

Problem Attempts to run programs that use IT Guru libraries result in “No such file or 
directory” errors.

Discussion The PATH environment variable must be set to include the correct IT Guru 
executable directory. Either the variable does not include the IT Guru 
executable directory or it is set for the directory of an earlier release.

Solution Make sure each user has the correct environment path, as follows:

Procedure 2-1   Checking the Environment Path

1 Log in to the user’s account.

2 Open the user’s shell startup file (.cshrc in the C shell).

3 Add the following directory to the user’s PATH variable.

<opnet_dir>/<release>/sys/unix/bin

End of Procedure 2-1
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Windows Installation Support

Most sites should follow the installation procedure described on the Windows 
Installation sheet. This procedure uses the setup program to automatically 
configure your computer and install IT Guru. However, if your computer has an 
unusual or incorrect configuration, the installation program may fail. If so, you 
can use the information here to solve the problem.

WARNING—Changing file systems on Windows platforms, such as from FAT 
to NTFS, will invalidate the license file. To maintain the validity of your licenses 
during a file system change, you should first de-register your licenses, then 
change the file system, and finally re-register your licenses. See Deregistering 
Licenses on page AG-2-11 and Reregistering Licenses After Moving System 
Software on page AG-2-12 for information on how to deregister and re-register 
licenses.

Windows Installation Troubleshooting

This section provides solutions for problems that may occur during Windows 
installations or operation. Each problem has a discussion section that explains 
what is happening and a solution section that explains how to solve the problem. 
If your problem is not listed here, contact Technical Support for help.

Problem Trying to run an OPNET licensed program results in the message: The OPNET 
licensing system depends on the following nonexistent service: Tcpip.

Discussion There is a problem with the TCP/IP software.

Solution Try installing TCP/IP again (as described in Procedure 2-2 on page AG-2-4), 
then repeat the step that failed. If the problem persists, contact OPNET 
Technical Support.

Problem Issuing the sup_info command in the op_license_util program produces 
the message “Ipc Port Entry (0) currently holds no addr” or a similar error.

Discussion There is a problem with the TCP/IP software.

Solution Try installing TCP/IP again (as described in Procedure 2-2 or Procedure 2-3), 
then repeat the step that failed. If the problem persists, contact the OPNET 
Technical Support staff.
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Problem The Windows setup program reports that TCP/IP is not installed.

Discussion The OPNET licensing system requires that the Windows TCP/IP software be 
installed. The TCP/IP software, in turn, requires the presence of an installed 
network adapter driver.

Solution Use the following procedures to install and configure the necessary software:

1) Procedure 2-2 Installing TCP/IP for a Network Connection 
(Windows NT 4.0) on page AG-2-4

or

Procedure 2-3 Installing TCP/IP for a Network Connection (Windows 2000) 
on page AG-2-5

2) Procedure 2-4 Verifying that a Network Adapter Driver is Installed on 
page AG-2-6

3) Procedure 2-6 Configuring TCP/IP on page AG-2-7

To install TCP/IP for a network connection on a Windows NT 4.0 computer:

Procedure 2-2   Installing TCP/IP for a Network Connection (Windows NT 4.0)

1 Verify that you are logged on as a user with administrator’s privileges.

2 Insert your Windows CD-ROM into the CD-ROM drive of the install workstation. If 
a Windows CD-ROM window opens, close it.

3 Open the Windows Control Panel and double-click the Network icon.

➥ The Network (Network Settings) dialog box opens.

4 In the Network (Network Settings) dialog box, click on the Protocols tab. Then click 
the Add… (Add Software) button.

➥ The Select Network Protocol (Add Network Software) dialog box opens.

5 Select TCP/IP Protocol (TCP/IP Protocol and related components) from the list of 
available software and click OK.

➥ The TCP/IP Setup dialog box opens.

6 If the install workstation is not on a network, answer No to the question about using 
a DHCP server. If the install workstation is on a network, consult your system 
administrator for the correct response.

➥ The Windows Setup dialog box opens, showing the path to the software on the 
CD-ROM.

7 Verify that the path is <CD-ROM_drive>:\i386, where <CD-ROM_drive> is the 
letter of the install workstation CD-ROM drive. Change the path if necessary.
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8 Click Continue.

➥ The TCP/IP software is installed from the CD-ROM.

9 Click OK, then Close to close the Windows Setup dialog box and return to the 
TCP/IP Setup dialog box.

10 Click on the IP Address tab and enter the IP number, subnet mask, and default 
gateway. (If you do not know these, ask your system administrator.)

11 Click on the DNS tab and enter the host name, domain name and DNS service 
search order. (The latter value is the IP address of your DNS server.)

12 Click OK to reboot your computer.

End of Procedure 2-2

To install TCP/IP for a network connection on a Windows 2000 computer:

Procedure 2-3   Installing TCP/IP for a Network Connection (Windows 2000)

1 Verify that you are logged on as an administrator or a member of the 
administrator’s group.

2 Insert your Windows 2000 CD-ROM into the CD-ROM drive of the install 
workstation. If a Windows CD-ROM window opens, close it.

3 From the Windows Start menu, choose Settings > 
Network and Dial-up Connections.

➥ The Network and Dialup Connections dialog box appears.

4 Double-click on the network connection for which you want install TCP/IP, then 
click Properties.

5 Click the General tab for a LAN connection, or the Networking tab for all other 
connection types.

6 If Internet Protocol (TCP/IP) does not appear in the list of installed components, 
perform the following steps:

6.1 Click Install, then Protocol, then Add.

➥ The Select Network Protocol dialog appears.

6.2 Select Internet Protocol (TCP/IP) from the protocols list, then click OK.

➥ Internet Protocol (TCP/IP) now appears in the list of supported protocols for 
the selected connection.

7 Double-click on the Internet Protocol (TCP/IP) list item to open the Internet Protocol 
(TCP/IP) Properties dialog box.

8 Specify your machine’s IP address.
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If your network is run on a DNCP server, choose Obtain IP address automatically.

If your network is not run on an DNCP server:

8.1 Click Use the following IP address... and enter the IP address, subnet mask, 
default gateway, preferred DNS server, and alternate DNS server.

9 Click Advanced... to open the Advanced TCP/IP Settings dialog box, then click the 
DNS tab. 

10 Enter the DNS suffix in the DNS suffix for this connection field.

11 Click OK to close the Advanced TCP/IP Settings dialog box and return to the 
Internet Protocol (TCP/IP) Properties dialog box.

12 Click OK to close the Internet Protocol (TCP/IP) Properties dialog box.

End of Procedure 2-3

Confirm that a network adapter driver is installed. If not, install a dummy driver. 
To verify that a network adapter driver is installed, perform the following 
procedure.

Procedure 2-4   Verifying that a Network Adapter Driver is Installed

1 If it is not already available, open the Network dialog box.

2 Click the Adapters tab to see if there is at least one adapter in the Network 
Adapters list.

• If there is at least one adapter in the list, continue with Procedure 2-6 Configuring 
TCP/IP on page AG-2-7.

• If there are no adapters in the list, you must install a “dummy” driver. Continue 
with Procedure 2-5.

End of Procedure 2-4

To install a network adapter driver, do the following procedure.

Procedure 2-5   Installing a Network Adapter Driver

1 In the Network (Network Settings) dialog box, click the Add… (Add Adapter) button.

➥ The Select Network Adapter (Add Network Adapter) dialog box opens.

2 Select MS Loopback Adapter from the list of available drivers.

3 Click OK (Continue) button.

➥ The MS Loopback Adapter Card Setup dialog box opens.
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4 Click OK.

➥ The standard 802.3 frame type is selected.

5 If prompted, enter the path to the software:

<CD-ROM_drive>:\i386

➥ The software is installed from the CD-ROM.

End of Procedure 2-5

To configure TCP/IP to work with OPNET, use the following procedure.

Procedure 2-6   Configuring TCP/IP

Note—This procedure may result in numerous error messages about various 
network services. You can ignore these messages.

1 In the Network dialog box, click the Protocols tab.

2 Click the Properties… (Configure) button.

➥ The Microsoft TCP/IP Properties (TCP/IP Configuration) dialog box opens.

3 Enter the following configuration information for the workstation. Your network 
administrator can provide appropriate values for your network.

IP Address—Enter the network address of the install workstation. If the workstation 
is not connected to a network, you can enter any value (1.1.1.1, for example).

4 Subnet Mask—Enter a value appropriate for the install workstation, if one is not 
entered automatically. (With the example IP Address in step 3a, the Subnet Mask 
would be 255.0.0.0.)

5 Default Gateway—Enter the address of the gateway used by the install 
workstation. Again, if the workstation is not connected to a network, you can enter 
any value (use 1.1.1.1 again).

6 Click OK.

7 If an alert dialog about adapter cards with an empty primary WINS address 
appears, you can generally continue by clicking Yes. If a problem occurs, consult 
your network administrator.

8 Close the Network (Network Settings) dialog box. Restart the install workstation if 
a dialog box suggesting this appears.

End of Procedure 2-6

The necessary TCP/IP software is now ready for use with the Floating License 
System.
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Update Installation Procedures

You must do an update system installation to install IT Guru on a server 
workstation where an earlier release of IT Guru is installed. A server workstation 
with IT Guru already installed normally has a directory called the OPNET 
directory. This directory has a subdirectory for each installed release of IT Guru.

The update installation will add a new subdirectory to the OPNET directory that 
corresponds to the new release. The new release will continue to use the 
existing license file and OPNET execution permits will remain usable after 
installation.

Running Previous Releases

If you have installed the latest version of the software, you can still run earlier 
releases by creating batch files to set the appropriate system variables 
(Windows) or by updating your PATH (UNIX), as described in the following 
procedures.

To run a previous Windows release, do the following procedure:

Procedure 2-7   Running Previous Releases of OPNET (Windows)

1 Use a batch file to set the opnet_dir, Lib, Path, and Include system variables (a 
batch file is any file with a .bat extension). 

For example, the following batch file could be used to set up an environment for 
version 4.0:

@echo off
set mil3_dir = c:\OPNET
set path = c:\opnet\4.0.A\sys\pc_intel_win32\bin;%path%
set lib = c:\opnet\4.0.A\sys\pc_intel_win32\lib;%lib%
set include = c:\opnet\4.0.A\sys\include;%include%
echo OPNET 4.0.A environment has been set up

When you want to run version 4.0, first run the above batch file in a command 
window (by typing the name of the batch file, including the extension), then issue 
the standard OPNET start-up commands from the same window (such as 
opnet -product itguru.

Note—The latest version of the license server (op_license_server) should be 
running on your machine, regardless of the OPNET version you are running. For 
example, if you run both release 7.0 and release 6.0, you should be running the 7.0 
license server. If you selected the “serve licenses from this computer” option during 
the license configuration portion of the installation, the new license server was 
automatically installed in place of any existing servers.

End of Procedure 2-7
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To run a previous UNIX release, do the following procedure:

Procedure 2-8   Running Previous Releases of OPNET (UNIX)

1 Reset your PATH variable for the OPNET version you want to run.

For example, to run version 6.0, you would reset your PATH as follows:

set path=(<opnet_dir>/6.0.A/sys/unix/bin $path)

Note—The latest version of the license server (op_license_server) should be 
running on your machine, regardless of the OPNET version you are running. For 
example, if you run both release 7.0 and release 6.0, you should be running the 7.0 
license server. If you selected the “serve licenses from this computer” option during 
the license configuration portion of the installation, the new license server was 
automatically installed in place of any existing servers.

End of Procedure 2-8
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Removing IT Guru System Software from Your Workstation

Typically, you want to free up the disk space used by an old release when it is 
no longer needed. If you are removing release 6.0 make sure you have 
converted your license file to the 7.0 format. See the installation information 
packaged with the CD or the Technical Support area of the OPNET 
Technologies web site for instructions.

To remove system software from a Windows workstation, do the following 
procedure:

Procedure 2-9   Removing System Software from a Windows Workstation

1 Log in as administrator to the machine where IT Guru software is located.

2 Choose Control Panel > Add/Remove Programs.

3 Select each item that begins with IT Guru, then click Add/Remove.

4 If you do not want to keep your IT Guru models and other data, delete the contents 
of directories <HOME>/<op_admin> and <HOME>/<op_models> and remove the 
directories.

End of Procedure 2-9

To remove system software from a UNIX workstation, do the following 
procedure:

Procedure 2-10   Removing System Software from a UNIX Workstation

1 Log in as root to the machine where IT Guru software is located.

2 Delete the directory containing the IT Guru software (<opnet_dir>/<reldir>).

3 If you do not wish to keep your OPNET models and other data, delete the contents 
of directories <HOME>/<op_admin> and <HOME>/<op_models> and remove the 
directories.

End of Procedure 2-10
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Relocating IT Guru System Software

If you want to move IT Guru system files from one computer to another, the 
simplest method is to uninstall the system software from the old location and 
reinstall it in the new location using the original installation CDs.

To do this, you must deregister licenses, uninstall, and reinstall the system 
software, then reregister the licenses in the new location.

WARNING—IT Guru will be unavailable during the following procedures. To 
minimize disruption, do the relocation operation during a low-use period and 
warn users in advance.

To deregister licenses, do the following procedure:

Procedure 2-11   Deregistering Licenses

1 (Windows only) Log in to the machine where the IT Guru system software is 
located.

2 Launch the License Manager:

Windows:

Select License Manager (Start > Programs > OPNET IT Guru 11.5 > 
License Manager).

UNIX:

Enter the following command:

op_license_manager

➥ The License Manager opens in one window. The IT Guru program opens in 
another window, but has limited functionality.

3 Revoke any licenses that are still in use by selecting the licenses and clicking on 
the Revoke License button.

4 In the License Manager treeview, choose the server where the IT Guru system 
software is located (it should be the machine you are logged into).

5 Deregister the licenses in that server’s license file:

5.1 Expand the license file icon.

5.2 Select and deregister all of the licenses in the license file by clicking on the 
Deregister License button and following the on-screen prompts.

6 Exit IT Guru.

End of Procedure 2-11
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To relocate the system software, do the following procedure:

Procedure 2-12   Relocating System Software

1 If you are not already, log in as root (or administrator) to the machine where the 
IT Guru system software is located.

2 (Windows only) Select Control Panel > Add/Remove Programs.

3 Select each item that begins with IT Guru, then click Add/Remove.

4 (UNIX only) Delete the directory containing the IT Guru software 
(<opnet_dir>/<reldir>).

5 Reinstall IT Guru in the desired location, using the original CDs. Follow the 
installation procedures outlined on the Installation sheets that were packaged with 
the CDs.

End of Procedure 2-12

To reregister licenses after moving the system software, do the following 
procedure:

Procedure 2-13   Reregistering Licenses After Moving System Software

1 Log in to a user account (or as a user) to the machine where the OPNET software 
is now located.

2 Launch OPNET by typing the following commands (where <program_name> is 
the executable name, such as modeler or itguru):

cd <reldir>/sys/unix/bin/
./<program_name>

3 When prompted, select License Management.

4 Click on the Add License button and follow the on-screen prompts.

End of Procedure 2-13
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3 Licensing

This chapter describes the OPNET licensing infrastructure, providing an 
overview of licenses, the licensing system, and the components of the licensing 
system. OPNET licensing includes two major components:

• License Manager

• License Server

The License Manager program is the graphical user interface (GUI) that allows 
you to interact with License Servers and license files. The License Manager can 
be used to manage License Servers and license files on local and remote 
computers.

A License Server is an application running in the background on a computer. 
When IT Guru is run, it looks for a License Server to grant it a license to run.

The Licensing System

The License Manager can oversee multiple license servers in a network. Each 
license server allocates licenses to one or more clients. IT Guru licenses, if not 
used in standalone mode, are floating licenses; this means that a pool of 
licenses is maintained by the license server. Any authorized user who can 
access the license server can use any free license. Licenses are not 
pre-assigned to a specific user. By default all users are authorized to obtain 
licenses. See Restricting License Users on page AG-3-29 for information on 
how to restrict the use of licenses.

The licensing system consists of these parts:

• License Servers—One or more computers, each running one license server. 
The license server is a service (on Windows platforms) or a daemon process 
(on UNIX platforms). Each computer has its own file of licenses, called 
license_file.

• Client machines—Clients request and are granted licenses from a particular 
license server. See Set as Default Server (button) on page AG-3-11 for more 
information.

• Licenses—Licenses allow a user to use specific applications (such as 
IT Guru) and modules (such as Multi-Vendor Import). See About Licenses on 
page AG-3-2 for details.
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Figure 3-1 shows an example of a licensing system.

Figure 3-1   License Manager Components

About Licenses

A license conveys the right to use an application. A license may be a single 
permit or a bundle of permits. A license typically bundles one or more 
applications (such as IT Guru), the simulation program, and one or more 
modules. Licenses are allocated on a per-permit basis. This means that a 
component that is part of a license (perhaps a module such as ACE) may be 
free and can be given to any requester, even if another component of the same 
license (most likely an application program) is in use.

Key Concept—You can turn on or off product modules such as Multi-Vendor 
Import (MVI). Choose License > Product Modules from the IT Guru system 
editor (the “splash screen” that appears when you start IT Guru), and check the 
options you want. When you are finished, restart IT Guru. 

License Files

Licenses are stored in a file named license_file. There can be only one 
license file on a machine. The file is stored in one of the following directories:

• Windows: <primary_hard_drive>:\OPNET_license

The <primary_hard_drive> is the first drive letter (usually C:) that names 
a non-removable, non-network, local drive partition.

• Solaris: /opt/OPNET_license or /var/adm/OPNET_license

Multiple License 
Servers can be running 
in the network.

Multiple licensed client 
machines can run in a 
single network, each 
running IT Guru.

Each License Server 
has a license file. When 

a request for a license arrives, it checks the 
license file for a valid license to issue.

The License 
Manager on a client 
machine can use 
any accessible and 
available license 
server.

License Server in 
Standalone Mode
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The default directory is /opt/OPNET_license, which must be a local 
directory (that is, not a symbolic link or mounted across a network). If /opt 
is not local, the license server will look in the /var/adm/OPNET_license 
directory. You cannot switch between these directories or specify which one 
will be used; the software will first try /opt/OPNET_license and only if that 
directory is not usable will it try /var/admin/OPNET_license.

License Manager 

The License Manager is the first component you encounter during installation. 
There are two ways to configure the licensing system during installation:

• Standalone mode—This allows you to run OPNET products only on the 
machine on which the license is installed.

• Floating mode—This allows the license server to issue licenses to run 
applications on multiple computers.

Regardless of the type of license installation, you can use the License Manager 
to administer application licenses. Typical license operations are

• Selecting a default license server

• Adding a license to the license file

• Extending the expiration or maintenance date of a specific license

• Starting or stopping a license server

• Reviewing usage statistics

Using the License Manager

This section describes how to start the License Manager and how to perform 
License Manager operations.

Starting the License Manager

You can start the License Manager the following ways:

• You can start the License Manager and IT Guru in the manage license mode. 
In this mode

— IT Guru does not use a license and has only limited functions. You will be 
able to use some system menu functions, but none of the editors.

— The License Manager opens automatically.

This mode is useful when you are performing license management functions 
only. You must use this mode if you are deregistering all licenses, because 
the License Manager will not allow you to deregister a license that is in use.
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• You can start the License Manager and IT Guru both with one command.

• You can start the License Manager from within IT Guru.

To start the License Manager from the Windows Start menu, perform the 
following procedure:

Procedure 3-1   Starting the License Manager From the Start Menu (Windows)

1 Select Start > Programs > Cisco Application Analysis Solution 1.1 > License 
manager.

➥ The License Manager opens in one window. The IT Guru program opens in 
another window but has limited functions.

End of Procedure 3-1

To start the License Manager with a script command, perform the following 
procedure:

Procedure 3-2   Starting the License Manager With a Script Command (UNIX)

1 Enter the following command:

op_license_manager

➥ The License Manager opens in one window. The IT Guru program opens in 
another window but has limited functions.

End of Procedure 3-2

To start the License Manager from a command line, perform the following 
procedure:

Procedure 3-3   Starting the License Manager From a Command Line

1 Launch the program (for example, itguru) with the manage_licenses preference:

<program> -manage_licenses

➥ The License Manager opens in one window. The IT Guru program opens in 
another window but has limited functions.

End of Procedure 3-3
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To start the license manager from within IT Guru, perform the following 
procedure:

Procedure 3-4   Starting the License Manager from Within IT Guru

1 Launch itguru.

2 Choose License > License Management.

➥ The License Manager opens.

Note—At least one license in the license file will be in use.

End of Procedure 3-4

About the License Server Tree

The License Manager shows information about the license servers in the 
network in a treeview.

Figure 3-2   License Manager Window
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Click on the “Help” button to see a legend and description, shown in Figure 3-3, 
of the icons shown in the License Manager window.

Figure 3-3   License Manager Help Screen
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Table 3-1 lists the elements of the license servers displayed in the License 
Manager window.

A license has several associated attributes, as listed in Table 3-2.

Table 3-1   License Server Elements 

Field Description

Requested Server This branch shows the server from which the IT Guru program can request and 
be issued licenses. You specify this server during Guru installation, by selecting 
it from within the License Server tree, or by listing the server name and port in 
your Preferences file in the license_server and license_port 
preferences, respectively. 

Operating System The OS version of the License Server is displayed in the tree.

OPNET Build The OPNET software version and build installed on the license server are 
displayed in the tree. 

Security Shows whether or not there is an admin_auth or user_auth file in place to 
control license management and usage. For more information, see Restricting 
License Server Administration on page AG-3-27.

Host IP Address The “Host IP address” given for each server is the return address of the IP packet 
received by the License Manager. This is not necessarily the actual IP address 
of the license server but could be the address of the firewall port through which 
the license server is accessed, for example.

System Date The system date of the License Server is displayed.

License File Path The full path of the license file location is displayed in the tree.

License File Shows the number and type of licenses installed on the server. See Table 3-2 
for more information on license attributes.

Local Servers Shows other license servers running on your computer.

Other Servers on this IP Network Shows other license servers running on your IP network segment.

End of Table 3-1
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Table 3-2   License Attribute Definitions

Attribute Description

Status This icon identifies the state of the license:

• A free license (shown in green) is available to the next user who requests it.

• An in use license (shown in white) is unavailable.

• An expired license (shown as yellow with red X) is no longer valid.

License number A unique pair of numbers that identifies the license. A license may bundle several programs. This 
means that a single license (for example, 100/1) that includes the programs IT Guru and 
Multi-Vendor Import will be shown as two separate lines in the License Manager interface.

Program name Controls which products or modules the license can run (such as IT Guru or the ACE module).

License expiration Controls how long you can use the license. After a license expires, it no longer runs OPNET 
products.

Maintenance expiration Controls which releases of the OPNET software can be run.

User If the license is in use, this attribute shows the name of the user who checked out the license.

Host If the license is in use, this attribute shows the machine where the license is being used.

Time in Use If the license is in use, this attribute shows the days, hours, minutes, and seconds elapsed since 
the start of use.

End of Table 3-2
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Operations

Operations fall into one of three broad groups:

• License Manager Operations (which are always available)

• Server Operations (the server of interest must be selected)

• License Operations (apply to a specific license or license file)

License operations are available from the drop-down menu. Many License 
Manager operations can also be accessed from a pop-up menu by right-clicking 
on a server, license file, or license icon in the treeview.

License Manager Operations

Export Tree (button) The license tree can be exported to a tab-delimited text file 
using the Export Tree feature. This feature is useful for troubleshooting.

Convert License File (File menu, button) Converts a pre-11.0 license file to a 
format the License Manager can use. After conversion, older license servers 
can use the license file, but you should only use the latest release of License 
Server to add or deregister licenses from the license file. You should convert the 
license file after the 11.0 installation process.

Note—The button to convert the license file is “Convert pre-11.0 License File”.

Note—If a license file is in an old format and needs to be converted, all 
operations except Stop Server, Start Server, and Convert License File are 
disabled. See License File Format Conversion on page AG-3-29 for more 
information.

Product Modules (Modules menu) Lets you specify which product options to 
use. Only the product options for which you have purchased licenses can be 
selected from the list. (Specialized model licenses are not listed here, but will be 
used when discrete event simulations are run.)

Server Operations

Start Server (button) Starts the selected server, allowing it to issue licenses and 
perform other license server functions. This button is active only when the 
selected server is your own (local) machine. To determine if a machine is local, 
type hostname in a shell window. See Procedure 3-5 on page AG-3-19 for 
details. You can also right-click on the server, and select “Start Server” from the 
pop-up menu. If the selected license server is already running, this button is not 
visible.
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Figure 3-4   Right-Click Server Operations

Stop Server (button) Stops the selected server. A server can be stopped even 
if running on a remote machine. See Procedure 3-10 on page AG-3-22 for 
details. You can also right-click on the server and select “Stop Server” from the 
pop-up menu, as shown in Figure 3-4. If the selected license server is not 
running or is in standalone mode, this button is not visible.

Figure 3-5   Right-Click Server Operations
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Update System Date (button) Allows you to reset the license server’s date, 
shown in the System Date field as described in Table 3-1, to the current date. 
Resetting the date requires that you contact OPNET via either the Internet, 
e-mail, or phone/fax. You can also right-click on the server, and select “Update 
System Date” from the pop-up menu, as shown in Figure 3-5.

Note—You might need to perform this operation because the server’s date is 
not the current date. This can occur even if the computer running the license 
server is set to the current date.

Set as Default Server (button) Sets user preferences so that the selected server 
is the default server. This server will be the requested server the next time you 
start IT Guru, and the values of the license_server and license_port 
preferences will correspond to this server. You can also right-click on a server 
other than the server you are currently using, and select “Set as Default Server” 
from the pop-up menu.

Refresh Server Information (File menu) Scans your network for license servers 
and rebuilds the tree.

Show Local Server’s Usage Statistics (Tools menu) Shows usage statistics for 
the local server.

Reset Local Server’s Usage Statistics (Tools menu) Resets the usage statistics 
for the local server.

Create License File (Button) This button appears only if there is no license file 
on the computer where the license server is running. When you click this button, 
a new license file is created. It will not have any licenses in it. Use the Add 
License (button) to add licenses. 

License Operations

The contents of the License file are displayed when you expand the License file 
folder under a selected server. You can right-click on a license file (when it is 
expanded to show the individual licenses) and sort the licenses for that server 
by license number, product type, status, or user.
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Figure 3-6   Example License File

You can restrict who has access to the following operations by creating an 
admin_auth file. If you do not create such a file, any user has access to these 
operations from any machine. See Restricting License Server Administration on 
page AG-3-27 for details. License operations are as follows. 

Add License (button) Allows you to add one or more licenses to a server. 
Requires that you contact OPNET by Internet, e-mail, or telephone (voice or 
fax). You can also right-click on a server to add a license from the pop-up menu, 
as shown in Figure 3-7. 

You can find detailed instructions on adding licenses on the OPNET Technical 
Support website: http://www.opnet.com/services/licenses_register.html.

Figure 3-7   Add License from Pop-Up Menu
Revoke License (button) Immediately revokes a license in use. The user of the 
license receives a warning and has two minutes to save files and exit the 
application.

Some licenses are in 
use.

Some licenses are 
free.
AG-3-12 IT Guru/Release 11.5



Administrator Guide 3—Licensing
Figure 3-8   Revoke License from Pop-Up Menu

Change Maintenance Expiration (button) Lets you set a new maintenance 
expiration date. You can change maintenance expiration from the pop-up menu 
by right-clicking on the license. The maintenance expiration date determines

• The time period for which you have access to OPNET Technical Support.

• Which release of an application you can run. For example, suppose you have 
installed the newest version of IT Guru, which has a release date later than 
the maintenance expiration of a particular license. That license will not run 
the new release, though it will run earlier versions of IT Guru. Licenses with 
a later maintenance expiration can run the new release.

You can find detailed instructions on changing the maintenance expiration date 
on the OPNET Technical Support website: 
http://www.opnet.com/services/licenses_register.html.

Change License Expiration (button) This button appears only if you select a 
permit that has an expiration. You cannot perform this function on a permanent 
permit. You can also right-click on a license and change its expiration.

You can find detailed instructions on changing the expiration date for a license 
on the OPNET Technical Support website: 
http://www.opnet.com/services/licenses_register.html.

Note—You can move a license from one license file to another. To do this you 
must first deregister the license from one license file, then add the license to the 
target license file. You can only deregister a license a certain number of times 
each year, as specified in your agreements with OPNET Technologies, Inc.
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Deregister License (button) This button removes a license from your computer. 
Typically, you will use this if the computer is about to be reformatted or 
decommissioned, or if you want to move the license to another license file. The 
button does not appear if you have selected a permit that is in use. You can also 
right-click on a license and deregister it from the pop-up menu, as shown in 
Figure 3-9.

You can find detailed instructions on license deregistration on the OPNET 
Technical Support website: 
http://www.opnet.com/services/licenses_register.html.

Figure 3-9   Deregister License from Pop-Up Menu

Clear License File (button) This operation deregisters all licenses from the 
license file in a single operation. This button appears only if no licenses in the 
file are in use. The choice also appears on the pop-up menu when you right-click 
on a license file, if no licenses in the file are in use. You should contact OPNET 
Technical Support by e-mail, phone, or fax before performing this operation.

When should you use “Deregister License” or “Clear License File”? These two 
choices perform the same operation but on a different scale.

• If you want to deregister all of your licenses in a single operation, use Clear 
License File. This deregisters all licenses in the license file at once, 
regardless of their contract number range. You must contact OPNET 
Technical Support by e-mail, phone, or fax before proceeding.

• If you want to deregister a selected license use the Deregister License 
operation and select which licenses will be removed from your license file. 
You do not need to contact OPNET Technical Support before performing this 
operation.
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Deregister License is the recommended method, because you do not need 
to contact OPNET Technical Support. Select the license of interest, click on 
the Deregister License button, and then click Express. Follow the prompts to 
remove the licenses from your license file.

Register New License (Tools menu) Same as the Add License button.

Validate License File (Button) This button only appears in rare circumstances in 
which a license file has become invalid. An invalid license file cannot be used to 
issue licenses. You must contact OPNET Technical Support to use this 
operation.
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License Server

WARNING—Your license server should run the latest OPNET release. A newer 
version of the license server can always serve licenses to earlier versions of the 
product.

License Server (op_license_server) is the application that issues licenses 
to licensed applications, when you use workgroup licensing. You may not need 
to directly invoke this application at all, because the graphical License Manager 
allows you to perform most common operations, including starting and stopping 
the license server. However, you may want to use the command line operations 
offered by op_license_server, perhaps by including commands in a script 
file.

Note—If you are using standalone licensing, Guru accesses the license file 
locally and does not use op_license_server.

op_license_server runs as a service (on Windows platforms) or as a 
daemon process (on UNIX platforms), issuing licenses to licensed applications. 
A daemon process is one that executes continuously without being attached to 
a user shell. Applications send messages to op_license_server by 
referencing its host (the workstation on which it runs) and its port (a unique 
identifier of a communications port on that host).

You can restrict who has access to certain server operations by creating an 
admin_auth file. If you do not create such a file, any user has access to any 
license operations on any server. See Restricting License Server Administration 
on page AG-3-27 for information.

You can restrict who can obtain licenses from a particular server by creating a 
user_auth file. See Restricting License Users on page AG-3-29 for details.
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Licensing Schemes

When you install Guru, you are asked to choose a licensing scheme. Table 3-3 
describes the use cases for each type of licensing.

Note—To change licensing schemes, you must reinstall the latest Guru version 
from your product CD or from a downloaded version obtained on the OPNET 
Support Center website. Normally this is all that is required to change the 
licensing scheme. However, if you previously used Edit > Preferences in 
IT Guru to change the value of the license_server_standalone 
preference, you must manually set license_server_standalone to the 
correct value after reinstalling the software.

Standalone Licensing

In the standalone configuration Guru acts as its own License Server, accessing 
the license directly without any intermediary program. When you use 
standalone mode, Guru may only be run on the computer where the license is 
installed.

Table 3-3 Licensing Schemes

Licensing Scheme Use Case

Standalone • OPNET products will be used only on the 
computer where the license is installed.

• All discrete event simulations (DES) will be 
launched from the IT Guru GUI, rather than from a 
command line or from a script.

• Report Server, 3DNV, or VNE Server applications 
are not used.

Workgroup/Floating • You want to share a license among several users 
in the same IP network.

• You want to run DES from command line, script, or 
batch file (outside the context of the IT Guru GUI).

• A VNE Server application will obtain its license 
from this License Server.

End of Table 3-3
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Workgroup Licensing

In the workgroup, or “floating”, configuration, op_license_server executes 
on a host computer that is on the same classful IP network as the clients it 
serves.

Note—The license server and clients must be in the same classful IP network. 
Therefore, unless the license server and the client have the same network 
address, licenses cannot be issued.

Within the local area network (LAN), multiple executing instances of 
op_license_server can coexist, but duplicate licenses (licenses with the 
same identification numbers) are not allowed. For example, if one license server 
allocates licenses 100-1 through 100-10, another license server cannot allocate 
those same licenses.
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Starting the License Server

There are several ways to start the License Server. op_license_server is 
typically started by one of the boot scripts of the host operating system. See 
section Stopping the License Server on page AG-3-22 for methods of stopping 
op_license_server.

When you invoke a licensed application (such as IT Guru), the application 
sends a request for a license to op_license_server. This license server 
examines the license file and, if a license is free, sends a reply granting the 
licensed application permission to run. If all licenses are in use, 
op_license_server sends a reply denying permission and the application 
notifies you.

Procedure 3-5 describes the preferred way to start the License Server. The 
remaining procedures in this section describe alternate methods for specific 
operating systems.

Regardless of the method you use, you should note these considerations:

• You can only start the local License Server (the one for the computer into 
which you are logged in).

• The OPNET License Server (op_license_server) must have read/write 
permissions on the license file to work correctly.

• If you installed Guru in standalone licensing mode, it will obtain licenses on 
its own. There is no need to start the license server in this case.

Procedure 3-5   Starting the License Server (Preferred Method)

1 Run the License Manager (as in Starting the License Manager on page AG-3-3).

2 Select the License Server for your computer in the License Manager treeview. (It 
will have a red dot in front of its name, indicating that it is not running.)

3 Click the Start Server button.

End of Procedure 3-5

Windows

There are two alternate ways to start the license server on Windows:

• Manually

• Automatically
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Procedure 3-6   Starting the License Server on Windows (Manually)

1 Start the Services application (in the Administrative Tools section of the Windows 
Control Panel).

Note—Your path to the Services application depends on your version of the 
Windows operating system. Please consult your Microsoft manual for assistance.

2 Locate OPNET License Server in the scrolling list of available services. If the 
Status column entry for this service does not read “Started”, select it and click the 
Start button.

3 The Startup column entry should read “Automatic”, which indicates that 
op_license_server will be started automatically whenever Windows is 
restarted. If this is not the case, change the Startup Type property to “Automatic”.

End of Procedure 3-6

If you want the License Server to start automatically whenever the computer is 
rebooted, follow Procedure 3-7.

Procedure 3-7   Starting the License Server on Windows (Automatically)

1 Install or reinstall IT Guru.

2 Select “Floating: Serve licenses from this computer” as your licensing scheme.

3 Complete the installation.

End of Procedure 3-7

UNIX

There are two alternate ways to start the license server on UNIX:

• Manually, from the command line

• Automatically, using auto-boot commands typically located in the /etc/rc 
file

Procedure 3-8   Starting the License Server on UNIX (Manually)

1 Log into the host computer where op_license_server is running.

2 Navigate to the binary directory (<bindir>) for your OPNET release and 
architecture.

3 Type the following command. 
AG-3-20 IT Guru/Release 11.5



Administrator Guide 3—Licensing
./op_license_server -license_port <port>

Note—If you do not know which port is available for op_license_server, enter 
“port_a”. If that port is unavailable, an error message will tell you which ports are 
available and you can re-enter the command with the correct port.

End of Procedure 3-8

Procedure 3-9   Starting the License Server on Solaris and Linux (Automatically)

Note—Root permissions are usually required for this procedure.

1 Create the following file: /etc/rc3.d/S999_opnet_lic_server.

2 Insert the following auto-boot commands into the file you created:

# OPNET License Server
echo 'starting OPNET License Server...'
<bindir>/op_license_server -license_port <port>

3 (Linux only) Copy the same script to /etc/rc5.d using the following command:

cp /etc/rc3.d/S999_opnet_lic_server /etc/rc5.d

End of Procedure 3-9
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Stopping the License Server

WARNING—Do not stop the License Server while any licensed application is 
running, unless you will bring the license server back up within 15 minutes. For 
best system behavior, ask users to stop using the software or revoke all in-use 
licenses with the License Manager before stopping the License Server.

Procedure 3-10 describes the preferred way for stopping the License Server. 
You can also use one of the alternate methods given for specific OS platforms.

Procedure 3-10   Stopping the License Server (Preferred Method)

1 Run the License Manager (as in Starting the License Manager on page AG-3-3).

2 In the License Manager treeview, select the license file of the server you intend to 
stop, and verify that no licenses are in use.

• If any licenses are checked out, you can forcibly revoke them. To do so, select 
and revoke those licenses. The user receives a warning message and a short 
grace period, allowing time to save files and exit the application. If the user does 
not exit, the application will quit.

• You can choose not to revoke any checked-out licenses if you will bring the 
license server back up within a few minutes.

3 Click the Stop License Server button.

End of Procedure 3-10

Procedure 3-11   Stopping the License Server on Windows (Alternate Method 1)

1 Invoke the License Manager program from the command line in the stop server 
mode:

op_license_util -license_server_kill -license_server <server> \
-license_port <port>

For information about op_license_util, see the Program Descriptions chapter 
of your product documentation.

End of Procedure 3-11

Windows

In addition to the preferred method, you can stop the License Server on 
Windows by starting the Windows “Services” application. Select OPNET 
License Manager from the list of available services, and click the Stop button to 
stop the supervisor service. You can also use Procedure 3-11.
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UNIX

Procedure 3-12 describes an alternate way to stop the license server on UNIX.

Procedure 3-12   Stopping the License Server on UNIX (Alternate Method)

WARNING—Use this procedure only when other methods do not work.

1 Determine the process id (pid) of op_license_server by logging into the 
process’ host and using the ps command.

2 Execute the kill command from the command line:

kill <pid>

End of Procedure 3-12

License Server Reporting

A new utility lets a license server track license usage statistics and produce 
statistical reports upon request. When tracking is enabled on the license server, 
you can generate reports from the license manager console, using two new 
commands, on any client. Either command lets you specify a number of days on 
which to report. 

• fldb_stats—Produces a usage report for the license server.

• license_stats—Produces a usage report for individual licenses.

The report displays on the screen, and a time-stamped .csv copy of the file is 
placed in your \op_admin\tmp directory.

Enable License Tracking

Use one of the following procedures, depending on your platform, to enable 
license tracking.

Procedure 3-13   Enable License Tracking (Windows)

1 Stop the license server, using Procedure 3-10 or Procedure 3-11.

2 Start the license server, adding the command to enable tracking.

2.1 Choose Start > Programs > OPNET IT Guru 11.5 > OPNET Console 11.5.
IT Guru/Release 11.5 AG-3-23



3—Licensing Administrator Guide
2.2 Type op_license_server -license_usage_tracking_enable 
[-license_usage_tracking_history_days <number of days>], 
at the DOS prompt.

Note—If you do not use the -license_usage_tracking_history_days 
<number of days> parameter, tracking is automatically enabled for a 30 day 
history.

End of Procedure 3-13

Procedure 3-14   Enable License Tracking (UNIX)

1 Stop the license server, using Procedure 3-10 or Procedure 3-12.

2 Start the license server, adding the command to enable tracking.

2.1 Open a shell.

2.2 Type op_license_server -license_usage_tracking_enable 
[-license_usage_tracking_history_days <number of days], at 
the prompt.

Note—If you do not use the -license_usage_tracking_history_days 
<number of days> parameter, tracking is automatically enabled for a 30 day 
history.

End of Procedure 3-14

Obtaining License Server Statistics

Once license tracking is enabled, you can generate statistical reports about 
license usage. Use one of the following procedures, depending on your 
platform, to generate a report.

License Server Usage Reports

A license server usage report provides license file statistics, including license ID 
(license number, contract number and program name), total time in use, 
average checkout time, number of checkouts, number of unique users who 
accessed the file, and user IDs of those who accessed the file.

Procedure 3-15   Generate License Usage Reports per Server (Windows)

1 Choose Start > Programs > OPNET IT Guru 11.5 > OPNET Console 11.5, to open 
a console window.

Note—You can generate the reports from any client machine that has access to 
the license server.

2 Type op_license_util -license_server <license_server_name>.

➥ A license server prompt displays.
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3 Type fldb_stats to print a usage report for the license server. 

➥ The report displays and scrolls on the screen.

4 Enter the number of days for which you wish to report.

5 Obtain a .csv copy of the report from your \op_admin\tmp directory.

Note—The naming convention of the file is 
license_usage_report_MM-DD-YYYY_HH:MM:SS.

End of Procedure 3-15

Procedure 3-16   Generate License Usage Reports per Server (UNIX)

1 Open a shell.

Note—You can generate the reports from any client machine that has access to 
the license server.

2 Type op_license_util -license_server <license_server_name>.

➥ A license server prompt displays.

3 Type fldb_stats to print a usage report for the license server. 

➥ The report displays and scrolls on the screen.

4 Enter the number of days for which you wish to report.

5 Obtain a .csv copy of the report from your /op_admin/tmp directory.

Note—The naming convention of the file is 
license_usage_report_MM-DD-YYYY_HH:MM:SS.

End of Procedure 3-16
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License File Usage Reports

A license file usage report provides license server statistics, including maximum 
number of concurrent users, maximum number of concurrent licenses in use, 
and average number of concurrent licenses in use. Figure 3-10 shows an 
example of the .csv file that is produced.

Figure 3-10   License File Usage Report

Procedure 3-17   Generate License Usage Reports per License File (Windows)

1 Choose Start > Programs > OPNET IT Guru 11.5 > OPNET Console 11.5, to open 
a console window.

Note—You can generate the reports from any client machine that has access to 
the license server.

2 Type op_license_util -license_server <license_server_name>.

➥ A license server prompt displays.

3 Type license_stats to print a usage report for the license server. 

➥ The report displays and scrolls on the screen.

4 Enter the number of days for which you wish to report.

5 Obtain a .csv copy of the report from your \op_admin\tmp directory.

Note—The naming convention of the file is 
license_file_usage_report_MM-DD-YYYY_HH:MM:SS.

End of Procedure 3-17
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Procedure 3-18   Generate License Usage Reports per License File (UNIX)

1 Open a shell.

Note—You can generate the reports from any client machine that has access to 
the license server.

2 Type op_license_util -license_server <license_server_name>.

➥ A license server prompt displays.

3 Type license_stats to print a usage report for the license server. 

➥ The report displays and scrolls on the screen.

4 Enter the number of days for which you wish to report.

5 Obtain a .csv copy of the report from your /op_admin/tmp directory.

Note—The naming convention of the file is 
license_file_usage_report_MM-DD-YYYY_HH:MM:SS.

End of Procedure 3-18

Restricting License Server Administration

You can restrict access to server administration operations by creating an 
administration authorization file (admin_auth) that is stored on a specific 
license server. This file specifies machines and users: only the users listed, 
when logged into the machines listed, can perform server administration 
operations on that server.

The following operations are restricted:

• Add License

• Revoke License (however, users who are already using licenses can always 
revoke their own licenses)

• Change Maintenance Expiration

• Change License Expiration

• Deregister License

• Clear License File

• Update System Date
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• Start Server

• Stop Server

WARNING—If you do not create an administration authorization file, any user 
from any machine has access to these operations.

The administration authorization file is a text file with the following format: 

<machine> <user>
...
<machine> <user>

You can use a plus sign (+) to mean any user or any machine, as shown in the 
following example.

engineering1 root
js_pizza_box jsmith
ww_NT wwilson
+ hhoover
engineering_test +

This example file shows that:

• any user logging in as root on engineering1 can perform server 
administration operations

• jsmith can perform operations when logged into js_pizza_box

• wwilson can perform operations when logged into ww_NT

• hhoover can perform operations when logged into any machine

• any user can perform operations when logged into engineering_test

Name the administration authorization file as admin_auth and place it on the 
license server for which you want to control administration operations, in the 
same directory as the license file:

Windows: <primary_hard_drive>:\OPNET_license\

Solaris: /opt/OPNET_license/ or
/var/adm/OPNET_license/

Linux: /opt/OPNET_license/

After adding or editing an administration authorization file, you must do one of 
the following things to make it take effect:

• In the License Manager, choose Tools > Refresh Server Authorization Files.

• Stop and restart the license server.
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Restricting License Users

You can restrict the users of a particular license server by creating a user 
authorization file (user_auth). In this file you list machine-user pairs that are 
allowed to receive licenses from that server. A license server with a user_auth 
file will grant licenses only to those machine-user pairs listed in the file.

WARNING—If you do not create a user authorization file, any user from any 
machine can obtain licenses and run applications.

A user authorization file is a text file with the same format as an administration 
authorization file (see Restricting License Server Administration on 
page AG-3-27 for details). Name the user authorization file as user_auth and 
place it on the license server for which you want to specify users, in the same 
directory as the license file:

Windows: <primary_hard_drive>:\OPNET_License\

Solaris: /opt/OPNET_license/ or
/var/adm/OPNET_license/

Linux: /opt/OPNET_license/

After adding or editing a user authorization file, you must do one of the following 
things to make it take effect:

• In the License Manager, choose Tools > Refresh Server Authorization Files.

• Stop and restart the license server.

License File Format Conversion

The format of the license file changed from release 10.5 to 11.0. Because of 
this, license files from pre-11.0 installations must be converted before the 
OPNET 11.0 license server can use them. After installing the 11.0 software, you 
must convert your license files by doing Procedure 3-19.

Until the license file is converted, the 11.0 license server will be unable to 
provide licenses to any 11.0 clients. (However, it can provide licenses to 
pre-11.0 clients.) After the license file is converted, 11.0 license servers will be 
able to serve licenses to both 11.0 and older license clients.

Procedure 3-19   Converting Pre-11.0 License Files

1 Start the 11.0 License Manager (as in Starting the License Manager on 
page AG-3-3).
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2 In the License Manager treeview, select the server whose license file you want to 
convert. Servers with unconverted license files are marked by a yellow dot with a 
C, as shown in the following figure.

3 Click the Convert Pre-11.0 License File button and follow the on-screen prompts.

Note—More detailed instructions on how to convert a license file are posted at the 
OPNET Support Center (www.opnet.com/support); follow the License Registration 
link to the Instructions section.

End of Procedure 3-19
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Troubleshooting

This section contains information intended to help you troubleshoot common 
problems, decipher licensing errors, and debug licensing operations.

Diagnose Mode

This section provides a description of the diagnose mode available for License 
Server and procedures specific to your operating system. 

Diagnose mode is not often used, because it is very verbose and creates large 
log files. However if you are debugging licensing behavior or looking for specific 
information about when and by whom licenses are checked out, then you can 
use diagnose mode.

The information generated by running the license server in diagnose mode is 
recorded to a file called license_server_log, which is located in

Windows: <primary_hard_drive>:\OPNET_license 

Solaris: /opt/OPNET_license/ or
/var/adm/OPNET_license/

Linux: /opt/OPNET_license/

This is the same directory where the license_file is located.

Note—The diagnose mode of the License Server writes verbose information to 
this file that will eventually create a large license_server_log. This file must be 
deleted occasionally.

To use the diagnose mode, follow the appropriate procedure:

• Procedure 3-20—Describes how to use diagnose mode on an ad hoc basis 
on Windows, Solaris, and Linux platforms.

• Procedure 3-21—Windows: Describes how to configure diagnose mode to 
start automatically when the computer is restarted. 

• Procedure 3-5—UNIX: Describes how to configure diagnose mode to start 
automatically when the computer is restarted.

Procedure 3-20   Starting the License Server in Diagnose Mode (Ad Hoc)

1 Log in to the machine where the License Server is running.

2 Shut down the License Server. See Stopping the License Server on page AG-3-22 
for more information.
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2.1 Start the OPNET License Manager.

2.2 Locate and select the License Server of interest from the left side of the 
License Manager window. 

2.3 Click the Stop button on the right side of the License Manager window.

➥ After a moment, the license server stops.

3 Start the OPNET License Server in diagnose mode:

Windows

3.1 Select OPNET License Server from the Services control panel:

Windows 2000, XP: Start > Programs > Administrative Tools > Services

Windows NT: Start > Settings > Control Panel > Services

• Right-click on the OPNET License Server service and choose Properties.

• Add -diagnose to the Start Parameters.

• Click on the Start button to start the License Server in diagnose mode.

UNIX

3.1 Open a c-shell.

Type the command op_license_server -diagnose &

Note—Make sure the path to IT Guru is in your shell PATH.

4 Inspect the license_server_log for the information you desire.

5 To disable diagnose mode:

5.1 Stop the License Server. 

5.2 Select the License Server of interest (in red).

5.3 Click “Start” to start the License Server in the normal mode.

End of Procedure 3-20

Procedure 3-21   Starting in Diagnose Mode for Windows (Recurrent)

1 Log in to the machine where the License Server is running.

2 Shut down the License Server. See Stopping the License Server on page AG-3-22 
for more information.

2.1 Start the OPNET License Manager.

2.2 Locate and select the License Server (indicated by the green dot) of interest 
from the left side of the License Manager window. 
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2.3 Click the Stop License Server button on the right side of the License Manager 
window.

➥ After a moment, the license server stops.

Note—You may need administrator privileges to perform these actions.

3 Modify the system registry. 

Note—Since you are editing your system’s registry, you should make a backup 
copy in case you need to recover.

3.1 Select Start > Run > “regedit”.

3.2 Navigate to the following key: \\My Computer\HKEY_LOCAL_MACHINE\ 
SYSTEM\CurrentControlSet\Services\OPNET License Server.

3.3 Double-click on “ImagePath”, in the right pane. 

➥ The ImagePath value appears in quotes.

3.4 Add the argument -diagnose to the end of the value (outside the quotation 
marks).

3.5 Exit the registry.

4 Start the OPNET License Server. See Starting the License Server (Preferred 
Method) on page AG-3-19.

4.1 Navigate to the Services panel.

Windows 2000, XP: Start > Programs > Administrative Tools > Services > 
OPNET License Server.

Windows NT: Start > Settings > Control Panel > Services > 
OPNET License Server.

4.2 Right-click on the OPNET License Server service, and select Start.

5 Close the Services panel.

End of Procedure 3-21

Procedure 3-22   Starting in Diagnose Mode for UNIX (Recurrent)

1 Modify the auto-boot scripts as described in Starting the License Server on 
page AG-3-19. 

2 Append the "-diagnose" flag to the command line as shown below: 

<bindir>/op_license_server -license_port <port_name> -diagnose

Note—Fill in your own installation directory for <bindir>; substitute the port (which 
defaults to “port_a”) for <port_name> in the example.

End of Procedure 3-22
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License Server Log 

The license server application (op_license_server) writes messages and 
errors to a log file. The log file, named license_server_log is located in the 
following directory:

Windows: <primary_hard_drive>:\OPNET_License\

Solaris: /opt/OPNET_license/ or
/var/adm/OPNET_license/

Linux: /opt/OPNET_license/

If the log file grows too large, you can remove it even when the license server is 
running.

The type and quantity of information written to the log file varies depending on 
whether the license server is operating in normal or diagnose mode.

In normal mode, the following events are logged:

• Start up and termination of the License Manager

• Arrival of an unexpected or invalid packet from a requesting application

• Inability to read from or write to the license database

• Use of an invalid license file

• Expiration of a license

In diagnose mode, the license server logs information on the following additional 
events:

• Requesting client is not on the same IP network as the license server

• License freed due to time-out

• License issued or refused

• Arrival of a continuation request from an application

• Arrival of a quit request from an application

• Arrival of a request to use a revoked or reissued license
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Common Problems and Solutions

Cannot Find License
Server You Wish to

Use

• If you cannot see the license server you want in the license treeview, you can 
add it to your license_managed_servers preference. (See Preferences 
on page AG-3-42). After editing the preference, click on File > 
Refresh Server Information in the License Manager.

• If the above method is problematic, you can also set the default license 
server by directly changing the license_server preference to the 
hostname or IP address of the computer that has the licenses you want to 
use.

• For standard workgroup licensing, the license server you choose must be in 
the same classful IP network as the computer on which you are running 
OPNET products.

• For loanable licensing, make sure you set the requested server to be a local 
License Server.

License Not
Obtained

If you see a dialog box telling you that a license was not obtained, consider the 
following possible solutions for each type of problem. The type of problem is 
described in the “What Happened?” section of the dialog box.

• There was no response from the license server.

— Are license_server and license_port set to the correct value, 
and are they spelled correctly? Use the “hostname” command to 
determine the exact spelling and capitalization.

— Is the specified license server running?

— Can the client ping the server? Can the server ping the client? This 
applies even if the server is the client. TCP/IP must be installed and 
running, even in standalone mode.

— Is the license server an older release of IT Guru? Run the latest release 
of the License Server.

— Rarely this may be accompanied by errors saying the op_models 
directory does not exist. It could be the case that changes to the 
preferences cannot be stored because IT Guru cannot write to the home 
directory. This can be due to permissions or because the directory does 
not exist.

• There are no licenses in the server’s license file.

— Set the license_server preference to a host with available licenses.

— Use the Add Licenses button in the License Manager to add licenses to 
the server's license file.
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• The license server did not grant your request for licenses.

— You may be running a License Server that is too old for your licenses. In 
that case upgrade to the latest available License Server. 

— In the case of the “11.0 License Not Obtained” error message, perform 
the “Convert pre-11.0 License File” operation described in 
Procedure 3-19. 

— Set the license_server preference to a computer with available 
licenses. 

— Use the Add Licenses button in the License Manager to add licenses to 
the server's license file.

— Deselect any product modules that are not in use.

• The only available license has expired or The only available license’s 
maintenance has expired.

— Perform the Change Maintenance Expiration operation if the current 
authorized maintenance date is not reflected in the license file. 

— Perform the Change License Expiration operation if the current 
authorized expiration date is not reflected in the license file.

— Be sure to use Select Product Modules to deselect product modules that 
are unavailable. 

— In rare instances you may need to perform the Update System Date 
operation, if License Server date is too far in the future.

• The requested license was found in the license server’s license file but it is 
in use.

— The most common cause of this message is that the license is in use by 
another user. 

— If IT Guru exited ungracefully, select the license in the License Manager, 
then click on the Revoke License button to revoke the permits that are 
erroneously listed as “in use”. (IT Guru will automatically recover from 
this situation after no more than one hour without intervention).

Note—VNE Server licenses are not recovered in the one hour time period. A 
license may not be automatically revoked for several days.

• The license server is a “standalone” license server. A standalone license 
server cannot issue licenses to other applications.

— An obvious remedy is to make sure you are selecting a License Server 
that is not in standalone mode.

— If you are certain you have selected the correct default server, switch the 
License Server to server mode. Stop the license server and (re)install the 
latest software patch level (on the server machine). During the 
installation, choose Floating: Serve licenses from this computer.
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• Your machine’s IP network address is different from the IP network address 
of the license server.

— You must use a License Server on your local IP network. Check to be 
sure you are using a License Server on your local IP network.

— This error can also occur if the computer running the License Server 
received a new IP address after the License Server was started. The 
solution is to restart the License Server by stopping it, then starting it 
again in the License Manager.

• The license server cannot write to its license file. A license server cannot give 
licenses unless it can write to its license file.

— Make sure the owner of the License Server process/daemon has 
permissions to write to the license file.

• The license server cannot lock its license file. A license server cannot give 
licenses unless it can lock its license file.

— Make sure the owner of the License Server process/daemon has 
permissions to create/delete files and directories in the OPNET_license 
directory. 

— Make sure enough disk space is available to create a small file or 
directory in the OPNET_license directory.

Note—A standalone License Server has the same permissions as the user 
logged in, while a License Server running in server mode typically has root or 
Administrator privileges.

• The license server’s license file is invalid. A license server cannot give 
licenses from an invalid file.

— Make sure you are running the latest version of License Server. If you are 
not running the latest version of License Server, you may encounter 
problems when adding, deregistering, or obtaining licenses.

— If you receive this error, refer to Validate License File (Button) on 
page AG-3-15.

• A license server’s license file does not exist. A license server cannot give out 
licenses without a license file.

— The license file may have been deleted, or the license server does not 
have permissions to create a new license file upon startup. If the license 
server should have a license file, check to see if it was deleted. 

— Otherwise, select a different license server.

— If necessary, refer to Create License File (Button) on page AG-3-11.
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• Your username/hostname is not authorized to obtain licenses from the 
license server.

— The user account or computer from which you are trying to access the 
license server is not authorized in the user_auth file. Check the 
user_auth file on the computer where the license server is running.

— For more information, refer to Restricting License Users on 
page AG-3-29.

— Try to login from an authorized account or computer.

No licenses in file If there are no licenses in your license file, you may need to sign your Electronic 
Licensing Agreement (ELA). To do this

1) Point your browser to the OPNET Support Center 
http://www.opnet.com/support.

2) Click on the License Registration link. When prompted, log in with your 
OPNET username and password. The License Registration page appears.

3) Click on the View Electronic License Agreements link. The OPNET 
Technologies, Inc., License Agreement Review page appears in a separate 
browser window.

4) Find the agreement that you are interested in signing. On the left side of this 
agreement, click on the Sign link.

5) Read the license agreement, then click on the Continue button at the 
bottom of the page.

6) The next page asks if you are authorized by your organization to sign the 
license agreement. Read the page, and if you agree, click the I Agree 
button.

7) The next page is the actual acceptance of the legal agreement. Read the 
page, and if you agree, click on the I Agree button.

Note—Each set of licenses has two agreements: Usage and Maintenance. You 
need to sign both agreements before your licenses will be available for use.

Error: A "SERVERS"
license is required

to use the
"server_definer"

process model

The SERVERS license, also called Server Specialized Model (SSM) is used for 
studying advanced server characteristics, such as the effect of disk access time, 
CPU usage, and other detailed aspects of server usage.

• If you intended to use this feature, but don’t have access to a server license, 
please contact info@opnet.com or your OPNET sales account manager.
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• If you did NOT intend to use this feature, you can fix the problem by

— making sure that the "Server: Modeling Method" on all nodes is set to 
"Simple CPU", and

— removing any "Server Definition" utility nodes from the network

You may see a similar error for other specialized models, including those in the 
following table:

Error: License
Invalid with code=4

An invalid license file with code = 4 indicates that an OPNET 10.5 (or previous) 
License Server was used to add licenses to a license file that is in the 11.0 (or 
later) format.

Resolve by deregistering all licenses from the file using the 10.5 License Server, 
then use 11.0 License Server to add them back.

Avoid this problem by always using the latest available version of the OPNET 
License Server and OPNET License Manager to perform license operations.

Error: License
Server's IP Address
Does Not Match the

IP Address of
Co-Located
Workstation

When you install a license server on your computer, the license is manipulated 
by a system service: op_license_server. If your computer's IP address 
changes (due to a dial-up or VPN connection, for example) between the time 
the License Server started and the time IT Guru is launched, the License Server 
process does not pick up the change. Restarting the license server will refresh 
its awareness of its IP address.

Table 3-4   Specialized Models

Model License

Server SERVERS

Circuit Switched CIRCSW

GPRS GPRS

PNNI PNNI

UMTS UMTS

DOCSIS DOCSIS

IPv6 IPV6

MPLS MPLS

Mainframe MFRAME

End of Table 3-4
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1) - Run the License Manager

2) - Choose the local license server process (green dot) from the server 
treeview

3) - Click the Stop Server button. After a moment, the license server stops.

4) - Click the Start Server button. After a moment, the license server starts.

Error: Bad
checksum [error

-16111]

The "bad checksum" error during license registration usually indicates one of 
two things:

• The Transaction Code was mistyped. Make sure that the complete 
Transaction Code was entered and that it doesn't have extra spaces or 
characters.

• The hostname was mistyped. Make sure you used the correct 
capitalization--this field is case-sensitive. Also check for extra spaces or 
characters.

Entries in License
Server Authorization

Files Do Not Work

• Make sure your license authorization files contain the correct format. A '+' 
may replace either or both fields to indicate that you want to allow all.

   hostname username

• After making any necessary changes to the authorization files, use the 
License Manager menu item Tools > Refresh Server Authorization Files, so 
the License Server uses the latest changes. For releases of License 
Manager 10.5 and earlier, you must stop and restart the License Server for 
the changes to take effect.

When Entering
Approval Code on
the Web, Receive

Error: "Multiple
Decryption Choices"

This message is most common with older releases of IT Guru. Older versions of 
the licensing system generated Transaction Codes that were less specific than 
they are now. Therefore, many times a Transaction Code made from either 
version could be confused with transaction codes from the other. That is what 
is meant by “Multiple Decryption Choices.” To avoid this problem

• If you are using the Express method, simply try the operation again.

• If you are using the Browser method to perform a license operation, discard 
the Transaction Code that caused this error message, and try again with a 
new Transaction Code.

Lost Confirmation
Code during
Registration

If you lost your Confirmation Code during a registration, you may see the error, 
“This license has a pending registration”. Confirmation codes are stored in the 
session log of the machine running the OPNET License Server.
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You can view the session log by choosing Help > Session Log > Open.

Note—Confirmation codes are not necessary with the Express method of 
license registration.

Potential Server or
DNS Configuration

Error

If you receive an error similar to this, there is usually not a true problem:

<<< Diagnostic Error >>>
* Package: Vos (Virtual Operating System)
* Function: Vos_Sec_Fl_Dmn_Versioned_Ping
* Error: Potential server or DNS configuration error:
License server (X) returned (Y) as its host name.

This means that your preference settings for the License Server differ from what 
the server reports. This can happen when the server has multiple hostnames or 
interfaces. 

To prevent the message

• Refer to the server in your preferences by the correct hostname or IP 
address.

• Suppress this and other diagnostic error messages by setting the 
diag_enable preference to FALSE.
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Preferences

Licensing preferences are supported by any licensed application, such as 
IT Guru and op_runsim. Preferences enable you to configure various aspects 
of program operation. 

license_group

Specifies your group ID number, the number assigned to you by OPNET when 
you purchased the software. To find your group ID, choose About This 
Application from the Help menu. Your group ID is used for express license 
registrations on the OPNET Technical Support web site.

license_http_proxy_password

Specifies a password to use when authenticating to an HTTP proxy server. If 
your site controls access to the Internet with an HTTP proxy server, you should 
set this preference to allow OPNET express licensing transactions to take place. 
This preference is stored in encrypted format.

license_http_proxy_port

Specifies an HTTP proxy server port to be used for express license 
registrations.

license_http_proxy_server

Specifies an HTTP proxy server to be used for express license registrations.

Data Type string

Default Value ““

Data Type password

Default Value ““

Data Type integer

Default Value 80

Data Type string

Default Value ““
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license_http_proxy_user

Specifies a user name to use when authenticating to an HTTP proxy server. If 
your site controls access to the Internet with an HTTP proxy server, you should 
set this preference to allow OPNET express licensing transactions to take place.

license_http_server

Specifies the web server the License Manager uses when performing license 
transactions via the OPNET web site.

license_http_use_proxy

Specifies whether to use an HTTP proxy server for express license 
registrations.

license_managed_servers

Specifies a space-separated list of <server>, <port> pairs to be explicitly 
contacted by the License Manager. This preference causes license servers that 
are not in the same IP network segment as the License Manager to appear in 
the license server treeview. If <port> is not specified, “port_a” is assumed. For 
example: iasimov,port_a sunblade11,port_b sunblade10.

Data Type string

Default Value ““

Data Type string

Default Value “licenses.opnet.com”

Data Type boolean

Default Value FALSE

Data Type string list

Default Value <empty>
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license_password

Specifies the password used for authentication before beginning an express 
license registration on the OPNET Technical Support web site. This is typically 
the same password you use when entering the User Community section of the 
OPNET web site. This preference is stored in encrypted format.

license_ping_old_servers

Specifies whether the License Manager should try to locate servers from pre-7.0 
releases of IT Guru. If TRUE, the License Manager will take longer to start up 
as it looks for old license servers on the network.

license_port

Specifies the name of the communication port. This preference can have one of 
three possible values: port_a, port_b, or port_c. This preference is used in 
conjunction with license_server to uniquely identify a server running the 
licensing process and must be assigned a value.

To determine which ports are available for use by op_license_server, run 
op_license_util in port check mode on the machine where a license server 
is to be run (op_license_util -port_check). The licensing system uses 
UDP/TCP ports for communication. Each port corresponds to a UDP/TCP port 
(port_a is 2047, port_b is 2123, and port_c is 2345).

On UNIX platforms, you can change this preference by stopping 
op_license_server, then re-starting it with the new license_port value.

license_server

Specifies the name of a server that has a license file and can allocate licenses 
to clients requesting them. The server name is a string that follows the naming 
conventions supported by the TCP/IP protocol suite. This means that simple 
names (such as cbanana) and dot-separated addressing domains 

Data Type password

Default Value ““

Data Type boolean

Default Value FALSE

Data Type string

Default Value “port_a”
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(athena.mit.edu) are supported. This preference is used with license_port 
to uniquely identify a server running the licensing process. An error will occur if 
a licensing process is not running on the specified host computer or if the host 
computer is not found. This preference must be assigned a value.

license_server_standalone

Specifies that itguru will run in stand-alone licensing mode. In this mode, the 
program acts as its own license server. Other machines cannot get licenses 
from this server. Only this single instance of the application will launch.

This preference can be used with itguru or op_runsim, but not with 
op_license_server. When this preference is TRUE, the license_server and 
license_port preferences are ignored.

license_server_standalone_diagnose

Specifies that itguru will run in stand-alone licensing mode and will send 
diagnostic information to the license log. In this mode, the program acts as its 
own license server. Other machines cannot get licenses from this server. Only 
this single instance of the application will launch.

This preference can be used with itguru or op_runsim, but not with 
op_license_server.

license_username

Specifies the user name that will be sent to the OPNET web server during 
express license transactions. Used with license_password to authenticate 
yourself to the web server.

Data Type string

Default Value “localhost”

Data Type boolean

Default Value FALSE

Data Type boolean

Default Value FALSE

Data Type string

Default Value ““
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mtn_warn_int

Specifies the interval in days between maintenance expiration warnings. These 
warnings are automatically displayed when you exit a program that requires a 
license, beginning 60 days before expiration and ending when maintenance is 
renewed. The warning appears every n days, where n is the value of this 
preference, except for the period beginning 7 days before expiration and ending 
7 days after expiration, when the warning appears every day.

op_license_server Preferences

op_license_server supports the following preference sets:

• Standard preferences

• Diagnostics preferences

• Licensing preferences (license_port only)

op_license_server also supports the following additional preference:

diagnose

This preference specifies that op_license_server run in diagnose mode, 
writing detailed information to the log file license_server_log. For more 
information, refer to License Server Log on page AG-3-34.

Run op_license_server in diagnose mode only when troubleshooting the 
license server.

For information about the Standard and Diagnostics preference sets, see 
Preferences on page ITR-2-1 of the Guru Reference Guide.

Data Type integer

Default Value 3

Data Type boolean

Default Value False
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